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About us @ @

About the Johnson Controls Partner Learning Portal Because your goal is to apply what you've learned, our state-of-the-art facilities include
The Johnson Controls Partner Learning Portal has been developed to help people succeed at fully equipped labs for hands-on exercises. Portable equipment simulators enable the
creating and managing quality building environments. We, at Johnson Controls, understand Partner Learning Portal to bring many of its courses to your location, yet still enable you to
that every individual has a different learning need. This learning platform has been developed practice what you've learned without jeopardizing building operations.

for your own learning curve. Our mission is to provide high-quality learning experiences that

reflect both the current state of the industry today and the direction its heading in the future. NP PN ENTS SN GGG (IR S ¢ AL T elr BT Ui e B E

working knowledge of environmental systems, including:
» Building Owners

Our curriculum has been developed by professional instructors who are experienced in the

. : : : : : . » Building Managers
building environments industry. Their extensive real-world experience and ability to share J J

their knowledge in a structured format assures you an enlightening and productive educational > Engineers

. » I r
experience. Do

» Maintenance Technicians

» Learn from Certified Instructors* with years of industry experience » Property Managers
» Experiment in our labs, using specially designed equipment simulators
» Find the learning opportunities
» Expand your knowledge in industry topics such as:
» Building Automation Systems
» Energy Management
» Heating, Ventilating, and Air Conditioning Systems
» Preventative Maintenance

» Automated Building Controls

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com



https://my.jci.com/sites/STA/SitePages/Home.aspx
mailto:BTS-EMEA-PartnerLearning%40jci.com?subject=

Training Options to Meet Your Needs

ONG

Our learning opportunities are designed to provide you with the knowledge and skills
necessary to effectively and efficiently operate your building’s systems. By using your newly
acquired abilities, you can maximize the potential of your building systems and increase your
return on investment. To help you take advantage of the benefits of our training, we offer

several ways to approach our courses. You can select from our:

e-learning Courses
To help you learn in our own space and time, we have developed and deployed several
e-learning modules, videos and job-aids in the learning platform. These are organized and

cataloged for your learning needs. Visit https://|ci-academy.com and select Catalog to browse

through the learning content.

Product Knowledge Webinars

We conduct regular product knowledge webinar sessions where several product experts talk
about new product launches and product features. These sessions are held to enhance your
Johnson Controls product knowledge and are free of cost. You will receive e-mail updates from

Johnson Controls regarding such webinar sessions.

Instructor-Led Classroom Learning Courses (Scheduled)

Regularly scheduled courses with both a classroom and lab component are conducted at our
Johnson Controls training locations. During class you will be using an iPad® to take notes and
highlight the material. When class ends you will take your notes and course material with you

on a USB Drive. Refer to the class schedules available at https://jci-academy.com for the dates,

locations, and prices of these courses. Note: No audio/visual recording equipment is allowed.

Instructor-Led Distance Learning Courses and Learning Packages

Learn in the convenience of your own home, office, or work location using Johnson Controls
instructor-led distance learning courses or learning packages. Learning packages include self-
study workbooks offering flexible, effective, cost-efficient opportunities to build knowledge
and skills. Our instructor-led distance learning courses and learning packages can be used

as preparation for a course, to refresh skills, or to provide an effective learning alternative if

attendance at a typical classroom course is impractical. Refer to https://jci-academy.com for the

list of instructor-led distance learning courses.

Courses Offered by Request Only

Some of our courses target a more specific audience and therefore, have lower demand. To
continue to satisfy the needs of those who still occasionally need these courses, selected courses
are only conducted upon request. These courses can be conducted at your site or at one of our
training locations. For this reason, these courses are not scheduled. To inquire about scheduling a

course, contact BTS-EMEA-PartnerLearning@jci.com.

Onsite Learning Programs

Johnson Controls training can help you make the most of your investment in learning by bringing
our instructors and classes to you or to the location of your choice. More and more companies
are realizing the value of bringing training onsite. Our onsite Courses can be the most efficient

and cost-effective way to train as few as six employees.

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com



https://jci-academy.com
https://jci-academy.com
https://jci-academy.com
mailto:BTS-EMEA-PartnerLearning%40jci.com?subject=

Enrollment Information

ONG

To achieve the most effective training, carefully evaluate the course content and objectives to
match your learning requirements. Class size is limited and is offered on a first-register,

first- attend basis.

To browse our catalog and enroll for courses, please visit https://jci-academy.com Payment

information is available on the PLP.

Confirmation of enrollment along with training location information will be sent to the learner
within five working days after receipt of your payment (if applicable). Upon receipt of your
confirmation, check it carefully and contact us via e-mail if you find any discrepancies. If you
do not receive an enrollment confirmation letter within two weeks prior to the start of class,

contact us to make sure that we have received your application. For information on training

locations and recommended hotels refer Training Locations & Hotel Information.

All flight & hotel booking are suggested to be done after you have received a class

confirmation e-mail from Johnson Controls 2 weeks prior to class date.

Substitution & Cancellation

Johnson Controls reserves the right to cancel classes and assumes no liability for expenses.
All registrants will be notified (via e-mail and phone) at least 15 days before the start of class
should a course be canceled. Full amount of the course will be refunded to learners, if such a

situation occurs.

Circumstances may occur that could prevent you from attending a course for which you
are enrolled. For this reason, we allow you to substitute another learner in your place at no

additional fee (needs to be communicated to BTS-EMEA-PartnerLearning@jci.com).

If no substitute learner is available and you must cancel your enrollment, charges will be

applicable as follows-
» 100% of the amount will be refunded if cancelled before 3 weeks of class start date.
» 50% of the amount will be refunded if cancelled within 3 weeks of class start date.

» No refund if cancelled within 10 days of class start date.

Schedule of Classes

The latest schedule of classes is available at https://jci-academy.com The schedule is subject to

change.

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com



https://jci-academy.com
mailto:BTS-EMEA-PartnerLearning%40jci.com?subject=
https://jci-academy.com

Training Locations & Hotel Information

Learners must call the hotels directly to make reservations. The Johnson Controls Corporate Training facility location 2

rate must be requested. Be sure to ask about complimentary shuttle services to and from our DSO, Light Industrial Unit Phase 5, Unit C-O2
learning centers. (These services are not available everywhere). Reservations made through a Dubai Silicon Oasis, Dubai United Arab
travel agency are not eligible for the discounted rate. Emirates

Google map location: https://goo.gl/maps/
XNLza7WKkW3mtCcW7

Training facility location 1
Block D, Floor 3, Office Park Building #56,

Located approximately 20 mins from Dubai
International Airport (DXB) and 35 mins from

Dubai Internet City, Al Maktoum International Airport (DWC).
Dubai, United Arab Emirates

Google map location: https://goo.gl/maps/
BUDkuKwjehMBhFik6

Suggested Hotel Accommodations
Premier Inn Dubai Silicon Oasis Hotel
Sheikh Mohammed Bin Zayed Road, Dubai Silicon Oasis,

Dubai UAE

. . ) Phone: +971 4 382 1555
Located approximately 25 mins from Dubai

Website:
International Airport
(DXB) and 35 mins from Al Maktoum

International Airport (DWC).

Suggested Hotel Accommodations Google map location:
Holiday Inn Express Dubai — Internet City,
Al Sufouh Dubai Knowledge Park — Dubai,UAE Radisson Blu Hotel Apartments
Phone: +971 4 427 5555 Plot #26-077 , Dubai Silicon Oasis
Website: Dubai, United Arab Emirates
Phone: +971 4 350 1111

Website:

Google map location:

Google map location:

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com



https://www.google.com/maps/place/Johnson+Controls/@25.1049767,55.1693659,18z/data=!4m5!3m4!1s0x3e5f6bbc597a5285:0x72349726c6f84e5!8m2!3d25.1050178!4d55.1684566
https://www.google.com/maps/place/Johnson+Controls/@25.1049767,55.1693659,18z/data=!4m5!3m4!1s0x3e5f6bbc597a5285:0x72349726c6f84e5!8m2!3d25.1050178!4d55.1684566
https://www.ihg.com/holidayinnexpress/hotels/us/en/reservation
https://www.ihg.com/holidayinnexpress/hotels/us/en/reservation
https://www.google.com/maps/place/Johnson+Control+Training+Centre/@25.1305863,55.385645,15z/data=!4m5!3m4!1s0x0:0x32052d7870b1f1f1!8m2!3d25.1305863!4d55.385645
https://www.google.com/maps/place/Johnson+Control+Training+Centre/@25.1305863,55.385645,15z/data=!4m5!3m4!1s0x0:0x32052d7870b1f1f1!8m2!3d25.1305863!4d55.385645
https://goo.gl/maps/8QfpWZaLwES2 
https://global.premierinn.com/en 
https://goo.gl/maps/N4nR2tEpUT82 
https://goo.gl/maps/N4nR2tEpUT82 
https://www.radissonhotels.com/en-us/hotels/radisson-blu-apartments-dubai-silicon-oasis
https://www.radissonhotels.com/en-us/hotels/radisson-blu-apartments-dubai-silicon-oasis
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Metasys Building End-User Facility Explorer (FX) ABCS :
Operators/Engineers Learning Path Learning Path BCPro ABCS Learning Path

Metasys ABCS Learning Path

EasylO ABCS Learning Path

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com




Metasys Building End-User Operators/Engineers Learning Path @

Click any course to learn the course detalils...

Metasys®
\_) Engine/Server

C-388-EN Metasys system C-389-EN Metasys system
extended architecture for O R extended architecture for
Building Operators Building Engineers

} !

C-3021-EN Introduction to Metasys User Interface

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com



https://jci-academy.com/contentdetails?id=65F8650D3CB84EEAB31426340A4F82F9
https://jci-academy.com/ContentDetails.aspx?id=8B4F40D6427540F0A49EF6ACA41CC498
https://jci-academy.com/ContentDetails.aspx?id=F5D505BFEBE74A83AAA9647248EE3929

Metasys ABCS Learning Path @

Click any course to learn the course detalils...

. HVAC/Controls
C-3021-EN : \_) Courses
. Suggested elLearnings
Introduction to Metasys - . Metasys® Field
User Interface — HVAC Introduction — Environment \_) BACnet Controller
t‘ > J.J Q Metasys® Field
C-13072-EN - HVAC Introduction - Systems LON Controller
Fundamentals of HVAC — . Metasys ®
Systems Suggested elLearnings \_) Sefne/SameD
¢< = L HVAC Introduction - Controls Suggested eLearnings/video \-) :\/IODBU.S
ntegration
C-13073-EN -
Fundamentals of BMS FAN 410 - 1.0 Introduction, HVAC Drawings & System Layouts \-) Gl
Control Systems —
y < > Introduction To Metasys \_) E-Learnings/Video
-
-l
Field Level Supervisory Level _ ) JCI KNX Controll
Engineering Career Path Engineering BACnet 101: Basic BACnet Terminology and Concepts \_) ONTOTEr
\/ =
Y |

Y
C-3022 Metasys User
: C-391-EN Metasys system
C-7010-EN LN-Series LONWORKS - —
C-14002-EN KNX iNX P | LO—N> Controllers Programming and extended architecture Interface.Graph|cs
Certification rotoco T IS Engineering & Setup Editor
roubleshooting T
- l{ . Modbus Integration T Metasys Ul
ne
Suggested elLearnings/video C- 10076 -EN Commis- C-397-EN Metasys C-10895-EN None
N L system extended = Configuring The > — Completed
C-4703-EN Metasys FEC FAN 410 - 2.0 BACnet Controllers sioning NIEx9 Modbus | < ” - -
Sperifeneieadiestie ' . Integrations architecture Advanced Archive Database &
B & Devices - T Engineering Metasys Ul
l< >| P | l GGT
FAN 410 - 4.0 BACnet Cable & C-10077-EN Suggested elLearnings/video C-3002-EN Metasys
Installation Standards Programming NIEx3 N Graphics Generation  |—
Engineering & Programming FAN 410 - 5.1 Installation ) = T
I Validations Using FIT Tool r
= BACnet-103: BACnet Communications — Messaging
|
: B
C-4704-EN Metasys FEC Custom BACnet-102: BACnet -
Programming — Communslcatlons - Network BACnet-104: Expanding on BACnet Standard Capabilities
= tructures B

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com



https://jci-academy.com/contentdetails?id=65F8650D3CB84EEAB31426340A4F82F9
https://jci-academy.com/ContentDetails.aspx?id=8B4F40D6427540F0A49EF6ACA41CC498
https://jci-academy.com/ContentDetails.aspx?id=2305320EEC5B406FBD9CF839D540024C
https://jci-academy.com/ContentDetails.aspx?id=064BEB82ABFF4157A7CD3C0CF33385A4
https://jci-academy.com/ContentDetails.aspx?id=99BBD0BE388C4E8993F810053C7A57F2
https://jci-academy.com/ContentDetails.aspx?id=CD30F038874C475D860C9B6B9126AB94
https://jci-academy.com/ContentDetails.aspx?id=554A1CD695A2494780778B7DA89A06E1
https://jci-academy.com/ContentDetails.aspx?id=188E687C6974434BB7B8BFBB4144DCF8
https://jci-academy.com/ContentDetails.aspx?id=857FAFA3988244EF8231B4E5736CAAB5
https://jci-academy.com/ContentDetails.aspx?id=4F63925CDE08472B896D06819F02FAD2
https://jci-academy.com/ContentDetails.aspx?id=8CEDAFF1A65043D5807E7FD56C9C737F
https://jci-academy.com/ContentDetails.aspx?id=E63908032C144497A58E20BDBF548A2C
https://jci-academy.com/ContentDetails.aspx?id=F5D505BFEBE74A83AAA9647248EE3929
https://jci-academy.com/ContentDetails.aspx?id=F5D505BFEBE74A83AAA9647248EE3929
https://jci-academy.com/ContentDetails.aspx?id=8B4F40D6427540F0A49EF6ACA41CC498
https://jci-academy.com/ContentDetails.aspx?id=6275E6980D124DFC999D35FA370CEFCE

Facility Explorer (FX) ABCS Learning Path ®

Suggested elLearnings Click any course to learn the course detalils...
- HVAC/Controls
HVAC Introduction — Environment C-13072-EN Courses
- » || Fundamentals of HVAC FX Field BACnet®
B Systems Suggested elLearnings Controller
HVAC Introduction - Systems
o FX® Supervisory /
l < > HVAC Introduction - Controls | Server
E-Learnings/Video
C-13073-EN Suggested elLearnings/video
Fundamentals of BMS !
Control Systems FAN 410 - 1.0 Introduction, HVAC Drawings & System Layouts : :
2 i’ / Suggested elearnings/video
- 1
- - |
l i Networking Fundamentals
BACnet® 101: Basic BACnet® Terminology and Concepts | J_. \
® 5 ® H H H
Fiold Level A Supervisory Level S BACnet™-103: BACnet™ Communications — Messaging
Y Engineering v Engineering < > : *
C-4714-EN BACnet®-104: Expanding on BACnet® Standard Capabilities
Facility Explorer (FX) — ¥
MSTP Field Controller C-4721-EN .
Tnglineciling Facility Explorer (FX) N4 Super- . Completed L Changing Passphrase of New FX80
visory Controllers Engineering I
- *
. Suggested elLearnings/video N Suggested elearnings/video
C-3821
Building an FX FAN 410 - 2.0 BACnet® Controllers & Devices BACnet® & N2 Trunks Tuning Policies
Supervisory Network . 7 7
Controller (SNC) N = \/
FAN 410 - 4.0 BACnet® Cable & Installation Standards Polling Subscription & Tuning Policies Part 1 - Overview
-
l - ¥ - 7
FAN 410 - 5.1 Installation Validations Using FIT Tool Polling Subscription & Tuning Policies Part 2 - Enhancements
_
C-3001-EN E Y =
Advanced PCT/CCT BACnet®-102: BACnet® Communications - Network Structures
i B
Programming —~ 1)
Configuring FX IP Controllers Curriculum

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com




BCPro ABCS Learning Path @

. Click any course to learn the course detalils...
Suggested elLearnings

- Q HVAC/Controls
C
HVAC Introduction — Environment e
C-13072-EN | .
- BCPro® Field
. > I Fundamentals of HVAC Q BACnet Controller
HVAC Introduction - Systems SIS Suggested elearnings ‘
- Q BCPro® Router/Server
l( > HVAC Introduction - Controls |
\-) E-Learnings/Video
C-13073-EN Suggested elLearnings/video |
Fundamentals of BMS \_) MODBUS Integration
Control Systems FAN 410 - 1.0 Introduction, HVAC Drawings & System Layouts
*( > l
Field Level /\ Supervisory Level i .
¥ Engineering Career Path Engineering BACnet® 101: Basic BACnet® Terminology and Concepts
C-4714-EN \/ l

Facility Explorer (FX)

. Suggested elLearnings/video
MSTP Field Controller C-14001-EN a
Engineering BCPro Ul Engineering & — Networking Fundamentals
l‘ Graphics _:r v
l > BACnet-103: BACnet Communications — Messaging
C-3001-EN . 4 el ings/vid - )
uggested eLearnings/video
Advanced PCT/CCT - 99 J — BACnet-104: Expanding on BACnet Standard Capabilities
Programming FAN 410 - 2.0 BACnet® Controllers & Devices Modbus No -
J‘J \‘, Integration
FAN 410 - 4.0 BACnet® Cable & Installation Standards
J_J * l ll Yes I
FAN 410 - 5.1 Installation Validations Using FIT Tool C- 10076 -EN C-10077-EN
J_l ) Commissioning NIEx9 —>  Programming NIEx9 Modbus |——> Completed
BACnet®-102: BACnet® Communications - Network Structures Vileelans (Mg Eens IElolEE

S —] —

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com



https://jci-academy.com/contentdetails?id=65F8650D3CB84EEAB31426340A4F82F9
https://jci-academy.com/ContentDetails.aspx?id=8B4F40D6427540F0A49EF6ACA41CC498
https://jci-academy.com/ContentDetails.aspx?id=F5D505BFEBE74A83AAA9647248EE3929

EasylO ABCS Learning Path @

Suggested eLearnings Click any course to learn the course detalils...
- ’ HVAC/Controls
HVAC Introduction — Environment C-13072-EN \_) Courses
— » 1| Fundamentals of HVAC ’ EasylO FS &
B Systems Suggested elLearnings \_) FW Field Controller
HVAC Introduction - Systems
oy ’ N4 Supervisory /
l < > HVAC Introduction - Controls \_) Server
_ _ . . E-Learnings/Video
C-13073-EN Suggested elLearnings/video \-)
Fundamentals of BMS
Control Systems FAN 410 - 1.0 Introduction, HVAC Drawings & System Layouts : :
2 i’ / Suggested elearnings/video
< > l B
Networking Fundamentals
BACnet® 101: Basic BACnet® Terminology and Concepts | J_J \
® 5 ® H H H
Fiold Level i . Supervisory Level BACnet™-103: BACnet™ Communications — Messaging
] Engineering areerra Engineering = > : *
\/ BACnet®-104: Expanding on BACnet® Standard Capabilities
C-14003-EN T 7
CPT Tool Training C-4721-EN =
Facility Explorer (FX) N4 Super- > Completed L Sremging FEsspinEse @ N P
l( visory Controllers Engineering I
v
Suggested elLearnings/video Suggested elLearnings/video
: i
Advanced CPT EasylO - CPT Training Video's BACnet® & N2 Trunks Tuning Policies
Programmin —
rogr ing = ¥ JA 0
FAN 410 - 4.0 BACnet® Cable & Installation Standards Polling Subscription & Tuning Policies Part 1 - Overview
i
S \ = v
FAN 410 - 5.1 Installation Validations Using FIT Tool Polling Subscription & Tuning Policies Part 2 - Enhancements
- \‘, -
I
BACnet®-102: BACnet® Communications - Network Structures

— v

EasylO - Advance CPT Training Video's

For further information on classes or help registering, please contact BTS-EMEA-PartnerLearning@jci.com




C-4714-EN Facility Explorer (FX)/BCPro MSTP Field Controller Engineering @ @

Course Information - PLP Link

Course Type Classroom Audience - Pre-Requisites Course (s) -
Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamental Student must have a strong knowledge of the JCI
Contractors Only. field controllers. A familiarization with BAS systems would also be
Category Controls beneficial.
Map Facility Explorer (FX)
BCPro ABCS Learning Path

Course Description Learning Objectives
Participants will receive an overview of the FX MSTP field controller system, create Course Topics:
programs from standard tree systems using the Programmable Controller and » Introduction to the FX MSTP Field Controllers system

Commissioning tool, then connect to Bluetooth and Zigbee connections and download » Creating applications using the standards tree

code into the controllers after setting up the hardware and software to communicate
properly.

» Establish Peer to Peer communications

» Using Bluetooth to connect to controllers

» Downloading and uploading controllers

» Commissioning inputs and outputs

» Commissioning state based strategies

» Implementing Zigbee Wireless communications
» Making custom changes to controllers

» Programming blocks

» Analyzing PID loops and Hybrid activities

» Configuring Sequencers and Multistage Controllers

» Troubleshooting network systems

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com



https://jci.sumtotal.host/core/pillarRedirect?relyingParty=LM&url=https:%2F%2FJCI.sumtotal.host%2Flearning%2Fcore%2Factivitydetails%2FViewActivityDetails%3FUserMode%3D0%26ActivityId%3D298138%26ClassUnderStruct%3DFalse%26CallerUrl%3D%2Flearning%2Flearner%2FHome%2FGoToPortal%3Fkey%3D0%26SearchCallerURL%3Dhttps%253A%252F%252FJCI.sumtotal.host%252Fcore%252FsearchRedirect%253FViewType%253DList%2526SearchText%253D12364%2526startRow%253D0%26SearchCallerID%3D2

https://jci-academy.com/contentdetails?id=67E09730BB044CAFBE6AD45C4825BC1E

C-13072-EN Fundamentals of HVAC Systems @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 1 Day » Technicians/Engineers with minimal experience working on HVAC » Fundamental understanding of Microsoft® Windows™
Systems
Category Controls
Map Metasys ABCS Learning Path
Facility Explorer (FX)
BCPro ABCS Learning Path

EasylO ABCS Learning Path

Course Description Learning Objectives
This course is designed to provide technicians, engineers with basic knowledge of HVAC At the end of this module, you will be able to:
to have an overview of the refrigeration cycle and its components, understand P-H » Define the major processes in a HVAC system

Diagrams and Psychometric charts, Air side components — AHUs, Ducts and Airflow ,

» |llustrate a Refrigeration cycle on a P-H Chart
Water side components — Piping , pump curves and sizing.

» Use a Psychometric Chart to plot a cooling and dehumidifying process
» Explain the different components used on the Air-Side of a system

» Explain the different components used on the Water-Side of a system

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com



https://jci.sumtotal.host/core/pillarRedirect?relyingParty=LM&url=https:%2F%2FJCI.sumtotal.host%2Flearning%2Fcore%2Factivitydetails%2FViewActivityDetails%3FUserMode%3D0%26ActivityId%3D298138%26ClassUnderStruct%3DFalse%26CallerUrl%3D%2Flearning%2Flearner%2FHome%2FGoToPortal%3Fkey%3D0%26SearchCallerURL%3Dhttps%253A%252F%252FJCI.sumtotal.host%252Fcore%252FsearchRedirect%253FViewType%253DList%2526SearchText%253D12364%2526startRow%253D0%26SearchCallerID%3D2

https://jci-academy.com/contentdetails?id=65F8650D3CB84EEAB31426340A4F82F9

C-13073-EN Fundamentals of BMS Control Systems @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 2 Days » Technicians/Engineers with minimal experience working on HVAC » Fundamental understanding of Microsoft® Windows™
Control Systems

Category Controls

Map Metasys ABCS Learning Path

Facility Explorer (FX)

BCPro ABCS Learning Path
EasylO ABCS Learning Path

Course Description Learning Objectives

This course is designed to provide technicians, engineers with basic knowledge of controls At the end of this module, you will be able to:
and HVAC to have an overview of the Building Management Systems that includes
controls fundamentals, VAVs, CAVs and their control, Chiller Sequencing Strategies,
Protocols and BMS Equipment selection. Preparing an I/O summary for a BMS.

» Define the basic concepts used in a control system
» ldentify the types of Variable air volume systems
» Classify the various chiller sequencing strategies

» Sketch an I/O summary

» Explain BMS equipment selection

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com



https://jci.sumtotal.host/core/pillarRedirect?relyingParty=LM&url=https:%2F%2FJCI.sumtotal.host%2Flearning%2Fcore%2Factivitydetails%2FViewActivityDetails%3FUserMode%3D0%26ActivityId%3D298138%26ClassUnderStruct%3DFalse%26CallerUrl%3D%2Flearning%2Flearner%2FHome%2FGoToPortal%3Fkey%3D0%26SearchCallerURL%3Dhttps%253A%252F%252FJCI.sumtotal.host%252Fcore%252FsearchRedirect%253FViewType%253DList%2526SearchText%253D12364%2526startRow%253D0%26SearchCallerID%3D2

https://jci-academy.com/contentdetails?id=41D6D64B8B6849F8A619D6D08FAB0AD6

C-3001-EN Advanced PCT/CCT Programming @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » FX MSTP Field Controller Engineering (#4714) and PCG/PCV/PCX
Contractors Only. controller programming experience
Category Controls
Map Facility Explorer (FX)
BCPro ABCS Learning Path

Course Description Learning Objectives
Students must have a strong knowledge of Johnson Controls field controllers (C-4714-EN) Course Topics:
& A familiarization of building automation systems (BAS) would also be beneficial » Central Plant Application in PCT

» Modules and Blocks in PCT

» Activities as Containers

» Hybrid Activities

» PID and PID Pre-Processor

» State Tables

» Sequencer and Multi-stage Controller
» PRAC+ and PMAC

» Review of Custom Lab

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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https://jci-academy.com/contentdetails?id=68665C7EEFAD492C939B8278E31F5666

C-4721 EN Facility Explorer (FX)/EasylO N4 Supervisory Controllers Engineering @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 5 Days » For End Users and/or Authorized Building Control Specialists/ Students must have a strong knowledge of Johnson Controls field
Contractors only. controllers (C-4714-EN) & A familiarization of building automation

Category Controls

systems (BAS) would also be beneficial
Map Facility Explorer (FX)

EasylO ABCS Learning Path

Course Description Learning Objectives

Basic instruction on design, engineer and program projects using FXWorkbench Pro Course Topics:

running on Niagara 4. » Course Introduction and System Overview » Controller Summary
» Supervisory Controller User Interface Overview » Hierarchy Services
» FXWorkbench Pro Overview » Commissioning and Backing
» Creating a Station up a Station
» Adding N2 and BACNet® MSTP Controllers and Points » Auto discovering BACNet®
» Extension Manager and Extensions points
» Control Logic » Using Standard Graphics for
» Tagging Objects Other Devices
» Scheduling » Enterprise Connectivity
» Defining Users and Roles » Technical Program Examination
» Customizing Access Permissions
» Setting up Email Notification of Alarms
» Graphics

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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https://jci-academy.com/contentdetails?id=865D6FB047CC4B29B4D7C673A9E4DD83

C-14001-EN BCPro Ul Engineering & Graphics @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 2 Days » End Users and/or Authorized Building Controls Specialists/ Students must have a strong knowledge of Johnson Controls field
Contractors Only. controllers (C-4714-EN) & A familiarization of building automation

Category Controls

systems (BAS) would also be beneficial

Map BCPro ABCS Learning Path

Course Description Learning Objectives
In this Two-day course, students will learn an overview of the BCPro Ul Graphics tool with Course Topics:
its features and terminology. » Exploring the BCPro Ul

» Planning for the Ul for New site
» Import Database and graphics creation
» Custom graphics with BCPro Ul.

» Trend, Calendar & Alarming creation.

» Interlock Programming

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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https://jci-academy.com/contentdetails?id=529DFB919C8B4E90AB42003F103C5841

C-14002-EN KNX Certification QED

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 5 Days » End Users and/or Authorized Building Controls Specialists/
Contractors Only.
Category Controls
Map Metasys ABCS Learning Path

Course Description Learning Objectives
KNX is the worldwide leader in hospitality sector, bringing thousands of users and Course Topics:
professionals in a unique technological world ready for the future. » KNX Project Design ETS Professional: Basic

» KNX Project Design ETS Professional: Advanced (only for informative purposes)
» KNX Commissioning ETS

» KNX Diagnostics & Trouble Shooting ETS
» KNX System arguments

» KNX System overview

» KNX TP Topology

» KNX TP Telegram

» KNX Bus devices

» KNX TP Installation

» KNX Powerline

» KNX RF

Certification Exam:
At the end of the KNX Basic course there is a theoretical and practical exam in order to test

the course participant’s basic KNX knowledge.

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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https://jci-academy.com/contentdetails?id=1D6D4EB162544FE0BB7D873F7F23D941

C-10076-EN -Commissioning NIEx9 Modbus Integrations @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 1 Day » End Users and/or Authorized Building Controls Specialists/ » Modbus Protocol Overview for Technicians Prior to the Class
Contractors Only. » Download and obtain a temporary license for the VMD Generator
Category Controls Express.
Map Metasys ABCS Learning Path » Download and obtain a temporary license for Multi-application
SCRE ARCE Lesaliae ek protocol explorer (optional, but recommended).

Course Description Learning Objectives

Learn how to commission a NIEx9 Modbus integration using a VMD file previously created. Course Topics:

» Introduction to NIEx9 for Third Party Modbus Integration (Review of prework)

» Modbus Communication (Review of prework)

» Licensing

» The Vendor Model Definition (VMD) File

» Integrating the NIEx9 (including Troubleshooting)

» Mass Changes Tool

» Objectives

» Describe how the NIEx9 is integrated into Metasys using Modbus communications
» Integrate a NIEx9 into Metasys using a VMD file.

» Diagnose problems that can occur during an integration

» Recognize how Mass Changes Tool can be used to organize data

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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https://jci-academy.com/contentdetails?id=9C5490817AC747CFAACC849029E4ACDD

C-10077-EN Programming NIEx9 Modbus Tables *** @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 2 Days » Controls Technicians, Lead Systems Specialists, System Designer, Prior the Class
System Engineers » Download and obtain a temporary license for VMD Generator
Category Controls Express.
Map Metasys ABCS Learning Path » Download and obtain a temporary license for multi-application
SCRE ARCE Lesaliae ek protocol explorer (optional, but recommended).

Course Description Learning Objectives
Learn how to use the VMD Generator Express (VGE) to create and modify Modbus tables Course Topics:
needed for the NIEx9 integration platform. » Introduction to NIEx9 for Third Party Modbus » Integrate a NIEx9 into Metasys using
Integration (Review of pre-work) a VMD file.
» Modbus Communication (Review of pre-work) » Diagnose problems that can occur
» Licensing during an integration.
» The Vendor Model Definition (VMD) File » Recognize how Mass Changes Tool
» Integrating the NIEx9 (including Troubleshooting) can be used to organize data.
» Mass Changes Tool » Create a Modbus device VMD
» About the Modbus device VMD file file that enables the connection
» Create NIEx9 Modbus VMD files between Modbus and Metasys.
» Certification Assignment
» Objectives
» Describe how the NIEX9 is integrated into
Metasys using Modbus communications

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-388-EN Metasys system extended architecture for Building Operators @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamental understanding of Microsoft® Windows™
Contractors Only.
Category Controls
Map Metasys Building End-User
Operator

Course Description Learning Objectives

This three-day course teaches building personnel how to make the most effective Course Topics:
and efficient use of the features of a Metasys system extended architecture facility
management system. This course is for building personnel who have new installations of
Metasys system extended architecture using NAEs or NIEs or for those who have migrated
from their existing Metasys system.

» Metasys system extended architecture Overview

» Help File System

» Basic Navigation of the System with the User Interface
» Commanding Objects

» Scheduling

» Setting up Alarms

» Responding to Alarms

» Trending

» Tantalization

» Graphics

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-389-EN Metasys system extended architecture for Building Engineers @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamental understanding of Microsoft® Windows™
Contractors Only.
Category Controls
Map Metasys Building End-User
Operators

Course Description Learning Objectives
This course teaches building personnel how to make the most effective and efficient use Course Topics:
of the features of a Metasys system extended architecture facility management system. » Metasys system extended architecture Overview > Reviewing Control Strategies
This course contains additional topics not covered in the Metasys system extended » Help File System » Backing Up the Data
architecture for Building Operators course. » Basic Navigation of the System with the User » Hands-on Labs

Interface » Final Review

» Commanding Objects
» Scheduling

» Setting Up Alarms

» Restponding to Alarms
» Trending

» Totalization

» Graphics

» Setting Up Passwords
» User Views

» Audit Trails

» Sending Reports to Printers, Pagers, Emails, etc.

» Adding Inputs and Outputs to a Controller

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-3021-EN Introduction to Metasys® User Interface @ @

Course Information - PLP Link

Course Type Classroom Audience - Pre-Requisites Course (s) -
Duration 6 Hours » End Users and/or Authorized Building Controls Specialists/ » Fundamental understanding of Microsoft® Windows™
Contractors Only.
Category Controls
Map Metasys ABCS Learning Path
Metasys Building End-User
Operators
Course Description Learning Objectives
This course is designed for customers who need to learn how to perform daily tasks using Course Topics:
the Metasys® User Interface. After completing this course, participants will be able to » Navigate the New User Interface
navigate through the Metasys® Ul to find the information that is relevant to your » Understand the differences of the Space Dashboard and Equipment Dashboard
building. You will be able to complete daily tasks using the interface by focusing on issues » Selecting widgets
that are critical to your site and take action on potential problems, leveraging advanced » Using the Alarm Manager
reporting capabilities for building analysis. » |ssuing commands
» Search for and report on Metasys® data using Advanced Search
» Understand how the User Interface may be customized at your site
» Finding additional resources

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-4703-EN Metasys FEC Operations/Troubleshooting @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamentals of HVAC Systems (C-13072) & Fundamentals of
Contractors Only. HVAC Control Systems(C-13073) or equivalent experience.

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

Upon successful completion of this course, the participants will be able to commission In this two-day course, students will learn how to access and read existing strategies and how to
BACnet MS/TP Field Equipment Controller (FEC) systems using the Controller download and test existing configurations on the Field Equipment Controllers (FECs). The course
Configuration Tool (CCT) through a wireless commissioning converter (BTCVT). is designed for building personnel who want to gain a better understanding of HVAC Control

Systems and Johnson Controls FEC devices.

Course Topics:

» Overview of FEC Controllers » Hands-on Labs
» Controller Configuration Tool (CCT) Overview » Final Review
» Bluetooth Wireless Communications

» Downloading and Uploading FEC Controllers

» Control Strategies and State Control

» Modifying Points in an FEC Controller

» FEC and IOM Hardware

» MS/TP Communications

» Trunk Utilities

» VMA Controller

» |nstallation Practices

» Simulation Mode in CCT

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-4707-EN Metasys FEC Engineering & Programming @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamentals of HVAC Systems (C-13072) & Fundamentals of
Contractors Only. HVAC Control Systems(C-13073) or equivalent experience.

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

Develop standard and modified HVAC system applications using Controller Configuration Students will learn how to program and test control strategies for theFieldEquipment Controllers
Tool (CCT). Modify and/or augment the software of CCT software for a small to mid-size (FECs) in this three-day course. The course is designed for experienced building personnel
projects to onsite changes. who want to expand their knowledge of HVAC Systems and Johnson Controls FEC devices.

Course Topics:

» FEC Controller Overview

» Controller Configuration Tool (CCT) Overview
» Control Strategies

» State Control Basics

» Creating a New Application
» Simulation Mode

» Program Modification

» Program Analysis

» Data Flow

» Side loops

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-4704-EN Metasys FEC Custom Programming @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys FEC Systems Engineering (#4707) and FEC controller
Contractors Only. programming experience.

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course provides participants with the skills to use CCT to make major modifications to Students will learn how to create and test customized control strategies for FEC controllers in
standard systems to complete unusual HVAC system control sequences for BACnet MS/TP this 4.5-day course.The course is designed for experienced building personnel who want to
Field Equipment Controller (FEC) devices. expand their knowledge of HVAC Control Systems and Johnson Controls FEC devices.

Course Topics:

» Central Plant Application in CCT
» Modules and Blocks in CCT

» Activities as Containers

» Hybrid Activities

» PID and PID Pre-Processor

» State Tables

» Sequencer and Multi-stage Controller
» PRAC+ and PMAC

» Review of Custom Lab

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-391-EN Metasys system extended architecture Engineering & Setup @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys FEC Systems Engineering (#4707). A familiarization
Contractors Only. with BAS systems or knowledge of operating the Metasys system

Category Controls

extended architecture would also be beneficial

Map Metasys ABCS Learning Path

Course Description Learning Objectives

Students will learn how to set up and manage the NAE database and to use the power of Course Topics:

the System Configuration Tool to generate an NAE database from existing ASC controller » Course Introduction
programming. » System Overview and Comparisons

» NAE User Interface Overview

» System Configuration Tool Overview

» Adding BACnet Devices

» Newest Feature Objects

» Overview: Designing a New Archive Database
» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-397-EN Metasys system extended architecture Advanced Engineering @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture Engineering and Setup
Contractors Only. (#391) or Metasys system extended architecture for Building

SR Homiliels Engineers (#389) & Student must have background in operating

Map Metasys ABCS Learning Path and/or engineering the Metasys system extended architecture.

Course Description Learning Objectives

Experienced personnel will learn how to write advanced programs for facility-wide or Course Topics:

specific mechanical control applications using the System Configuration Tool (SCT). » Review Metasys system extended architecture Control Objects (Interlocks, Multiple
Students will build, modify and troubleshoot routines they create. Commands, LCT, etc.)

» Reset Strategies

» Sequencing Equipment

» Rotation of Equipment

» Operating Equipment per Load Needs

» Lead Lag Strategies

» Creating Calculations Including Tonnage, Highest Daily Temperature, etc.
» Student Directed Topics and Activities

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-3002-EN Metasys Graphics Generation Tool @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture for Building Engineers
Contractors Only. (#389) OR Metasys system extended architecture Engineering

Category Controls

and Setup (#391).
Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course teaches students how to create and modify the custom graphics used to both Course Topics:

monitor and actively change building parameters and settings in a Metasys automation » Introduce the “Style Guide'”

system. It is a three-day online internet course which combines active instructor » Familiarize the student with how to commission graphics.

facilitation with student practice sessions with the facilitator available for questions. » Familiarize the student with how to create new graphics using the Graphic Generation Tool.
This course is for individuals already familiar with Automation System graphics or other » Provide an opportunity for hands-on practice implementing key Graphics+ tasks.

computerized graphic creation.

In this three-day course, students will learn an overview of the Graphics + tool with its
features and terminology.

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-10895-EN Configuring the Archive Database & Metasys Ul @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 2 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture Engineering and Setup
Contractors Only. (#391).

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course focuses on the tasks related to configuring spaces and equipment for Objectives

the Metasys Ul, for a new Metasys site You will learn the importance of engaging the At the end of this lesson, you will be able to:

customer in defining how the site appears in the Ul, how to configure the Ul using the » Introduce the customer to their newly created Metasys User Interface for New project
Rapid Archive Creation (RAC), and finally the tasks related to the customer turnover » Use SCT to geneate the database with the Metasys Ul configure Spaces and Equipment
meeting related to the Ul. You will complete. » Describe the importance of working with the customer to define the spaces tree

» Describe how configuration decisions impact the data visible in the Ul

Course Topics:

» Exploring the Metasys Ul

» Planning for the Metasys Ul for New site
» Rapid Archive

» Customer Turnover of the Metasys Ul.

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-3022-EN Metasys® User Interface Graphics Editor @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 6 Hours » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture Engineering and Setup
Contractors Only. (#391) & Configuring the Archive Database & Metasys Ul

Category Controls

(C-10895-EN)
Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course is designed for customers who have experience with the Metasys® User Course Topics:

Interface, but want or need to learn how to create Metasys® Ul Graphics. After » Access the Graphics Manager through the User Online/Offline
completing this course, participants will beable to navigate the Metasys® Graphics » Navigate the Graphics Manager

Manager, import and export graphics and associate a graphics to a space, equipment » Import and export graphics using the Offline User Interface
definition, or piece of equipment and add custom behaviors to a graphic. » Navigate through the Graphics Editor

» Create and edit the Master Layer for a site

» Create, edit, and associate a graphic to a space or piece of equipment
» Create and edit a floorplan

» Create and edit user defined graphics templates

» Add custom behaviors to graphics

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-7010-EN LN-Series LONWORKS Controllers Programming And Troubleshooting

O @®

Course Information - PLP Link

Course Type  Classroom Audience -
Duration 5 Days

Contractors Only.
Category Controls
Map Metasys ABCS Learning Path

Course Description

» End Users and/or Authorized Building Controls Specialists/

Learning Objectives

Pre-Requisites Course (s) -

» Metasys system extended architecture Engineering and Setup
(#391) & Student must bring their laptop to class with a licensed
version of LN Builder installed, and a LON Talk Adapter such as
the 75010 USB interface

This course provides an opportunity for hands-on practice using the Metasys system LN
controllers to configure typical applications for each controller type, using the LN-Builder
database management tool. The course also provides an opportunity to map LonWorks
points into the Metasys extended architecture system.

Objectives:

After completing this course, the learner will

be able to:

» Select appropriate Metasys system LN
LonWorks device

» Configure Metasys system LN Application
Specific Controllers

» Apply a simple strategy using a Metasys
system LN Programmable Controller

» Configure the NAE for LON

Course Topics:

» Introduction to the Metasys system LN series
of LonWorks controllers

» Obtaining & installing software plug-ins

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com

» Obtaining other Johnson Controls support
material.

» Johnson Controls Metasys system LN
Application Specific product

» Controller selection,

» Configuration peculiarities

» Johnson Controls Metasys system LN
Programmable products

» Introduce the Graphical Programming
Language

» Configuring the NAE for LON,

» Employ standard snippets and master
library objects

» Build and save custom Snippets
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C-14003-EN CPT Too Training @ @

Course Information - PLP Link

Course Type  Virtual Audience - Pre-Requisites Course (s) -

Duration 4 Days (4 hour per Day) » End Users and/or Authorized Building Controls Specialists/ » HVAC & BMS Fundamental must have a strong knowledge of the
Contractors Only. field Installation. A familiarization with BAS systems would also

Category Controls

be beneficial.
Map EasylO ABCS Learning Path

Course Description Learning Objectives
EasylO is a robust and flexible line of IP-based controllers. The participant will be able to Objectives: Required Hardware & Software
identify various EasylO controller types and uses for each. Additionally the participant will After completing this course, the learner will > Laptop computer running Windows 7 or
. . . : . . , higher operating system
write programming logic, set up dashboards and graphics, as well as integrate various be able to:
. . . . . . > (3) Network patch cords
protocols. The Course will be delivered virtually over the period of 4 days in 4 Course Topics: N it
hour(Instructor Training session) increments. The total training will be 16 hours & later » EasylO Product Fundamentals etwgr Swite
. , , » FS Series Controller (Preferably the FS-20)
Student will have 16 Hours Lab. » Programming the FW-Series and

» FW Series Controller (Preferably the FW-8)

> 24 VAC Power Supply to power the
controllers at the same time

» HTML-5 Compatible Web Browser

» FS-Series Controllers
» BACnet IP Server and BACnet Client
» Dashboards

» Backup / Restore Functions (Chrome Preferred)

» P2P Communications » CPT Tools (Supplied by Instructor)
> Apps Tool

» Graphics

» SQLite Database and Charts

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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C-3821-EN Building an FX Supervisory Network Controller(SNC) @ @

Course Information - PLP Link

Course Type  Virtual Audience - Pre-Requisites Course (s) -

Duration 4 Days » End Users and/or Authorized Building Controls Specialists/ » Students must have a strong knowledge of Johnson Controls
Contractors Only. field controllers (C-4714-EN) & A familiarization of building

Category Controls automation systems (BAS) would also be beneficial.

Map Facility Explorer (FX) ABCS

Learning Path

Course Description

This introductory course imparts foundational knowledge of database creation using the
System Configuration Tool (SCT and SCT Pro). The student will learn about the FX
Supervisory Plant Controller (SNC). The Rapid Archive Creator (RAC) is used to prepare and
build a database framework, and students learn how to complete the database after RAC
implementation. Students will prepare a SNC for database transfer. Using SCT and SCT Pro
to transfer Controller Application Files (CAF) to Field Controllers is also covered.

Learning Objectives

Objectives: Required Hardware & Software
After completing this course, the learner will » This is a virtual class so the student will
S a5 e be responsible for supplying equipment for

Course Topics:

>

>

>

>

v

>

v

>

v

>

v

the learning opportunity including:

» Personal Computer with the following
JCI FX SuperVisory Plant Controller (SNC) software installed and licensed

hardware overview | > CCT 14.0 (or later)
SCT and SCT Pro overview » SCT 14.1 (or later)

Archive Database Structure » FX Device Packages for SCT
Using Rapid Archive Creator (RAC) to

assist automated database building
Preparing the SNC

Using SCT/SCT Pro to transfer controller
configuration file into the SNC

Archiving databases from SNC and Field
Controllers

» FX Field Controller Packages

» Johnson Controls SA Bus Device
Packages

» F4-SNC25151 with 24 VAC power ready
for operation

For further information on classes or help registering, please contact BTIS-EMEA-PartnerLearning@jci.com
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